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Objective: Introduce users to Word, Excel and Outlook versions 2007 and highlight 
some of the enhancements in the new version that will increase efficiencies in the 
agency. 
 
Assumptions:  This seminar is based on the following 

Microsoft ® Word Version 2007 
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Office 2007 – Things they are a changin’ 

 
Microsoft has made some sweeping changes to the User Interface (that’s the part of the 
software a user sees) in their newest version of Office – version 2007.  Many of the 
changes are great improvements, however it can be frustrating to work with initially 
because so many things have been changed or moved.  The goal of this class is to 
introduce some to the bigger changes in the overall Office program and then specifically 
focus on Outlook, Word and Excel enhancements. 
 

General Office Features (shown in Word) 

 
There are certain features that transcend all the programs in Office Standard 2007 and 
those features are what this section is all about – the general Office 2007 features.   

Office Fluent user interface 

Microsoft has decided to give their new user interface a name… Office Fluent.  With this 
version they have designed a somewhat standard look and feel to the office products 
and acknowledged that the features displayed will change depending on what 
application you are in and what you have highlighted at the time. 
 

Office Button 

Think of this as old reliable.  A familiar looking menu appears when you click on the big 
button in the upper left hand corner.  From here you can Save, Print and Send your 
document to various places  - to name a few of the options.  This is also were you find 
the old Tools, Options dialog box, except now you click on the Button then Options 
button in the lower right hand corner.  This button is not available on all screens in the 
current version of Outlook. 
 

 
The Button 
The Ribbon   –   Tab Name   –  Group Name  -  Icon for dialog box 
Quick Access Tool Bar (your new best friend) 

The Ribbon 

The Ribbon replaces your old toolbars.  They are organized by task on tabs which are 
labeled above the commands.  (The Home tab contains many of the “commonly used 
features”.)  Each tab is then broken down into groups, which are labeled underneath the 
commands.  To see more details for a set of commands simply click on the icon to the 
right of the group name and a detailed dialog box will open.  The Ribbon is not available 
on all screens in the current version of Outlook. 
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Quick Access Toolbar 

Your new best friend!  This customizable toolbar allows you to add your FAVORITE 
buttons from any ribbon to this easily accessible location.  Simply right-click on the 
button you like and choose Add to Quick Access Toolbar.  Decide you don’ t like a 
button that is already on the Quick Access Toolbar, just right-click on the button and 
choose Remove from Quick Access Toolbar. 
 

Live Preview 

This is really cool, but is not available for all commands – which can make it a bit 
difficult to get used to.  On the most basic level, the way this feature works is, if you 
hover over a button with your mouse – but do not click – you will see that command 
applied to your document in a preview state.  If you like the changes, simply click the 
button and the changes will be permanent.  If you don’t like the changes, hover over 
another button.  Some of the commands that WILL live preview are Styles, Fonts and 
Colors (if chosen from the expanded box).  Some of the commands that WILL NOT live 
preview include Bold and Italics. 
 

Export to PDF or XPS 

PDF and XPS are two file formats that preserve document formatting and Office 2007 
will allow you to export to either format without purchasing any additional software.  
Before you can start using this feature, a free “add in” must be installed on your 
workstation which is available from Microsoft’s website – www.microsoft.com/downloads 
then type in “save as pdf or xps” in the search box and you will be brought to the 2007 
Office Add-in for this feature.  Once installed, you find this option in the Office Button, 
under the Save As command. 
 

Spell Check 

Many of the spell check options are now global across all your Office applications.  That 
means if you make a change to the spell check options in Word – that change may be 
picked up in Outlook too.  (Notice the words many and may in the previous sentences… 
unfortunately it’s not all options – and there’s currently not a clear list of which options 
are global.  We do know that the custom dictionary IS global!)   
 
An exclusion dictionary is available in the Office suite.  This is a manual process, but is 
great for catching embarrassing typos…like if you forget to type the L in public.  The 
way the exclusion dictionary works is you enter, in all lower case with a hard return after 
each entry, the words that you want flagged as exclusion.  After you have saved and 
closed the document and restarted your Office programs, whenever one of the 
exclusion words are typed they will get a red squiggly line underneath them, indicating 
to the user that the word has been misspelled. The exclusion dictionary file can be 
found on a workstation in the following location.  
C:\Documents and Settings\username\Application Data\Microsoft\UProof 
 

http://www.microsoft.com/downloads
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Contextual Spell Check 

Another option in Office 2007 is Use Contextual Spelling.  This feature will look for the 
classic – I will see you THEIR!  - typos.  To turn this feature on or off go to Office Button, 
Options (in the lower right hand corner), Proofing.  This is also where you find all the 
AutoCorrect options and many other familiar friends. 
 

Outlook 

If you are coming from Outlook 2003, the user interface for 2007 is not THAT 
much different than what you are used to today.  If you are coming from an older 
version, the look and feel is quite new.  Below are some of the new features in 
Outlook 2007.  

To Do Bar 

This is the new area for your quick view of the priorities for the day.  It can display 
tasks, emails flagged for follow-up, and upcoming appointments to name a few.  It 
is found on the right side of your Outlook window.  You can customize its look and 
feel by right clicking on it.  There are three views available – Off, Minimized and 
Normal.  The minimized view is displayed on the right.  
 

Instant Search 

Instant Search is a quicker way to search Outlook for information.  Natively 
available in Office 2007 running on Windows Vista, Windows XP users can take 
advantage of this feature by downloading the Windows Desktop Search add-in 
from Microsoft’s website (www.microsoft.com/downloads) and typing in Windows 
Desktop Search in the search window.  Once installed, you can search for a word 
or phrase and easily expand your search to your entire mailbox. 
 

Tasks on Your Calendar 

Outlook 2007 now integrates Tasks with your Calendar.  When a task is entered in 2007 
it will appear on your Daily Task List on your calendar, so you will no longer need to go 
to the task window to see your pending tasks.  The great part about this feature is your 
task will continue to “move” to the next day’s calendar until it is marked as completed. 

Color Coding 

Outlook has given the ability to color code items in Outlook for several versions, and 
2007 now gives us MORE capabilities.  With Color Categories, you will now be able to 
add the same color to e-mail, calendar and task items.  The first time you use a Color 
Category, you will be given the option to rename the category from its original color 
name to something more meaningful.  To assign a Color Category, simply right click on 
your Outlook item and choose Categorize, then the appropriate color.  If you are feeling 
really fancy, explore the Quick Click option! 
 

To-Do Bar 
Outlook 2007 

http://www.microsoft.com/downloads
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You also have the ability to search on Color Category and if you have an Exchange 
Server your Color Categories will now roam with you.  (In previous versions they were 
stored in the local registry but they are now in your server default data file.) 
 

Attachment Previewing 

Attachment Previewing gives you the ability to quickly see an attachment in the reading 
pane of Outlook.  Natively, Outlook can preview Outlook, Word, Excel, PowerPoint, 
Visio, text and image files.  Other third party manufacturers (like Adobe) have 
introduced preview capabilities in their newer versions of software or via patches.  You 
will need to contact those manufacturers for details.  Macros and other scripting type 
features are disabled in Preview due to the risk of virus proliferation. 
 
Previewing an attachment is easy, just click on the attachment tab at the top of the body 
of the message.  To switch back to the e-mail message, click on the Message tab.  
Below you can see both views. 
 
Message View    Attachment Preview 

 
 
 
A word of caution when using the attachment previewing feature! 
If you want to PRINT an attachment in an e-mail… 
either right-click on the attachment in the e-mail message and choose print  
OR 
double-click on the attachment in the e-mail, opening it, and then print from that screen.  
 
If you simply click once on an attachment and review that attachment using the 
attachment preview and then click on the Print button in the e-mail window, you will print 
the BODY OF THE E-MAIL, even though what you are looking at the body of the 
attachment! 
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Navigation Pane Minimization 

In Outlook 2003, the Navigation Pane on the left side of the Outlook window 
changed dramatically.  In 2007, that pane hasn’t changed too much, but one really 
great feature was added… the ability to minimize the Navigation Pane!  Minimizing 
this pane gives you the ability to have a much larger workspace in Outlook 2007.  
When minimized, you can still move between the different areas in Outlook.  To 
switch between Normal and Minimized views, click the chevron at the top of the 
pane.  An image of the minimized pane is shown of the left. 
 

Meeting Requests 

Several enhancements have been added to the meeting scheduling area of Outlook 
2007.  You will no longer be able to send an out of date meeting request – Outlook 
will automatically send the most current if you try.  Also, if a change is made to a 
meeting’s location or agenda by the organizer, everyone will receive an informational 
update - they will NOT receive another meeting request, so they won’t have to 
accept the meeting again.  Changes will be highlighted in the informational update, 
so that attendees can more easily see the changes made by the meeting organizer. 

Calendar View Updates 

Calendar views and features have also been enhanced. 
You now have the ability to send someone a snapshot of your calendar via email.  To 
do this you must start with your calendar visible.   In the Normal Navigation Pane, click 
Send Calendar via E-mail.  You will then be able to enter an e-mail address and specify 
how many days you want to send.  Please note, the recipient gets a point in time image 
of your calendar, they will not receive any changes after you send the e-mail. 
 
Another new feature is Calendar Overlay.  This feature allows you to combine multiple 
calendars together – for viewing purposes only.  To overlay two calendars, you must 
have view access to both.  From your calendar, put a check mark in the Navigation 
Pane next to the calendars you want to merge, the calendars will appear side-by-side.   
In the name tab of the secondary calendar, click the View in Overlay Mode button.  If 
you want to overlay more calendars, repeat the steps above for each calendar.  To 
separate the calendars, click on the calendar’s name tab and choose View In Side-by-
Side mode. 

Out of Office Schedule 

If you have an Exchange Server running version 2007 you can now schedule your Out 
of Office Assistant ahead of time!  To do this open the Out of Office Assistant and 
choose Send Out of Office Auto-Replies.  Next choose Only Send During This Time 
Range and enter the range of the next time that you will be out of the office.  When that 
time arrives, the server will automatically start sending whatever out of office message 
you entered.  But remember, this is only available with Outlook 2007 AND Exchange 
2007. 
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Retired Features 

Now it’s time to say good-bye to some retired features. 
 
Personal Address Book – has been replaced with Contacts. 
Flag Follow-up – was only in Outlook 2003 – is being replaced by task flags and the 
enhanced color categories. 
Word as Your Email Editor – you now have no choice… you must use Word as your 
email editor. 
Task Pad – has been replaced with the To-Do Bar. 
 
 

Excel 

Most of the new features in Excel involve improving engines of existing tools within the 
program.  It’s not exactly hot off the press stuff, but it is much needed by those that use 
the tools. 

Expanded Grid 

First and foremost, Microsoft expanded the grid size in 2007 to 1,048,576 rows by 
16,384 columns!  That is going to help A LOT with those big searches we all run! 
 

Sorting 

The ability to sort has been dramatically expanded in this version.  Instead of having 3 
levels, you can now have up to 64 levels and you can now sort by color and custom list.  
See the Sort dialog box below.  Look on the Data Tab to find the Sort button. 

 

Page Layout View 

Familiar to many who spend a lot of time in Word, the Page Layout view has been 
added to Excel.  This gives you ability to see what the printed page is going to look like.  
To switch to Page Layout view, use the buttons toward the lower right corner of the 
Excel window. 
 



Introduction to Office 2007  
 

February, 2009 10 
   

Tables  

Tables have been greatly improved and more user friendly in this version.  If you like 
auto filter in previous versions… make sure you take time to play with Tables in this 
version.   When you change your spreadsheet to a table, the Column Label, instead of 
being A,B,C,etc., become the Heading you specify in your table, alleviating to need to 
freeze your top pane.  You can convert your data to a table using the Table button 
found on the Insert Tab. 
 

 


